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TMPC-FCA 
TLA Logic Analyzer 
Instruction Manual 

 
 

Protocol support for S-FPDP over 
Fibre Channel 

 
 
 

1 Support Description 
 
The TMPC-FCA Support Package provides capture and S-FPDP disassembly of packed 
Fibre Channel data output from the TMPC FCA-6 hardware.  Three independent Fibre 
Channel streams can be captured simultaneously on a 136-channel TLA module, with the 
display of S-FPDP  “disassembly” of one stream at a time. 

2 Installing the TMPC-FCA Support Package 
 
If you received the TMPC-FCA bus support via e-mail, then unpack .zip archive into a 
temporary folder (either on the TLA itself or accessible over a network by the TLA) and 
run the Setup.exe from the TLA.  If you received a TMPC-FCA installation disk or CD, 
insert the disk or CD in to the TLA run the Setup.exe from there. 
 
The installation program will automatically install the package software into the 
appropriate folders in the file system.  For the TMPC-FCA package, the support files will 
be installed into the “C:/Program Files/TLA700/Supports/TMPC-FCA” folder. 

3 Loading the TMPC-FCA Support Package 
 
To load the TMPC-FCA support package you must first select the logic analysis module 
that will be connected to the bus under test.  Only TLA 7XX mainframes with multiple 
modules will have more than one option.  To do this, bring up the System window from 
the Window menu.  Click in the title field to select the appropriate module.   
 
With the System window on top, select “Load Support Package…” from the File menu.  
A list box with all of the installed packages will pop up on the screen, allowing you to 
pick the package you wish to load into the logic analysis module.  Note that the list of 
support packages shown will depend on which packages have been previously installed 
on the TLA.   
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Select “TMPC-FCA” from the list and click on the Load button.  A dialog box with the 
following text will appear on the screen: 
 

“Loading a support package invalidates a module’s acquired data.  Do you 
wish to save the current module’s settings and data before loading the 
support package?” 

 
If you choose “Yes”, a “Save As…” file dialog box will appear, allowing you to save 
your current module setup and data.  Selecting “No” will cause the TLA to overwrite 
your current setup and data with the TMPC-FCA package setup. 
 
To load the support package in a second module, click in the title field of the second 
module in the System window and repeat the previous steps.   

4 Signals and Groups 
 
The FCA-6 hardware provides 8 mictor connectors, divided into two sets of 4 mictors.  
Each set of 4 mictors connects to a 136-channel TLA module and services 3 Fibre 
Channel streams, one mictor each for clock, valid, and data and a common mictor to 
carry other status and qualifier signals.   
 
The TMPC-FCA support package uses the following signals/groups for each channel, 
where ‘X’ is represents either channel A, B, or C: 
 

ClkX Clock for channel X 
ValidX Data valid for channel X 
DataX[31..0] Data for channel X 
StatusX[4..0] Status/qualifier signals for channel X 
- Bit4: CommaX Ordered set qualifier flag 
- Bit3: HoldBOTX Held ‘Beginning-Of-Transfer’ flag 
- Bit2: BOTX ‘Beginning-Of-Transfer’ flag 
- Bit1: EOTX ‘End-Of-Transfer’ flag 
- Bit0: BadCrcX Bad CRC flag 

 
All of the ClkX  signals are identical.  For convenience to the support package, this clock 
signal is also replicated as MClk on the  “helper” mictor connector.  The ValidX signal 
qualifies DataX, indicating that data that is valid.  In one of its normal acquisition modes, 
TLA records captured by the TMPC-FCA support package will have at least one ValidX 
signal asserted.  CommaX true indicates that the word is a Fibre Channel Ordered Set (as 
opposed to data or CRC).  BOTX and EOTX are asserted on the MEOF ordered set of a 
S-FPDP “Sync Without Data” and “Sync With Data” packet respectively.  HoldBOTX is 
asserted high when BOTX goes high and held until it is de-asserted when EOTX is 
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asserted high.  Finally, BadCrcX is asserted one clock after the CRC data word of a 
packet when there is a checksum error (i.e. during an MEOF or FEOF ordered set).   
 
One group of signals not associated with a specific channel, User[5..0], conveys the state 
of user-defined signals on the back DB25 connector of the FCA-6 hardware.  For the first 
set of 4 mictors (FCA-6 Channels A,B,C) , the DB25 pin association for User[5..0] is 7, 
6, 5, 4, 3, and 2, msb-to-lsb respectively.  For the second set of 4 mictors (FCA-6 
Channels D,E,F), the DB25 pin association for User[5..0] is 15, 12, 11, 10, 9, and 8. 

5 Mictor Connector Signals 
 
Tables 1-4 describe the FCA-6 mictor signal pin-outs.  Note that Agilent and Tektronix 
use different Mictor pin numberings; both numbering schemes are provided in the tables. 
 
 

 Table 1 - A CONNECTOR  
 Tek A3/A2 Agilent A1/A0 Tek  
 1 NC 1 2 NC 38  
 2 NC 3 4 NC 37  

ValidA 3 CLK:0 5 6 CLK:1 36 ClkA 
DataA31 4 A3:7 7 8 A1:7 35 DataA15 
DataA30 5 A3:6 9 10 A1:6 34 DataA14 
DataA29 6 A3:5 11 12 A1:5 33 DataA13 
DataA28 7 A3:4 13 14 A1:4 32 DataA12 
DataA27 8 A3:3 15 16 A1:3 31 DataA11 
DataA26 9 A3:2 17 18 A1:2 30 DataA10 
DataA25 10 A3:1 19 20 A1:1 29 DataA9 
DataA24 11 A3:0 21 22 A1:0 28 DataA8 
DataA23 12 A2:7 23 24 A0:7 27 DataA7 
DataA22 13 A2:6 25 26 A0:6 26 DataA6 
DataA21 14 A2:5 27 28 A0:5 25 DataA5 
DataA20 15 A2:4 29 30 A0:4 24 DataA4 
DataA19 16 A2:3 31 32 A0:3 23 DataA3 
DataA18 17 A2:2 33 34 A0:2 22 DataA2 
DataA17 18 A2:1 35 36 A0:1 21 DataA1 
DataA16 19 A2:0 37 38 A0:0 20 DataA0 
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 Table 2 - D CONNECTOR  
 Tek D3/D2 Agilent D1/D0 Tek  
 1 NC 1 2 NC 38  
 2 NC 3 4 NC 37  

ValidB 3 QUAL:0 5 6 CLK:2 36 ClkB 
DataB31 4 D3:7 7 8 D1:7 35 DataB15 
DataB30 5 D3:6 9 10 D1:6 34 DataB14 
DataB29 6 D3:5 11 12 D1:5 33 DataB13 
DataB28 7 D3:4 13 14 D1:4 32 DataB12 
DataB27 8 D3:3 15 16 D1:3 31 DataB11 
DataB26 9 D3:2 17 18 D1:2 30 DataB10 
DataB25 10 D3:1 19 20 D1:1 29 DataB9 
DataB24 11 D3:0 21 22 D1:0 28 DataB8 
DataB23 12 D2:7 23 24 D0:7 27 DataB7 
DataB22 13 D2:6 25 26 D0:6 26 DataB6 
DataB21 14 D2:5 27 28 D0:5 25 DataB5 
DataB20 15 D2:4 29 30 D0:4 24 DataB4 
DataB19 16 D2:3 31 32 D0:3 23 DataB3 
DataB18 17 D2:2 33 34 D0:2 22 DataB2 
DataB17 18 D2:1 35 36 D0:1 21 DataB1 
DataB16 19 D2:0 37 38 D0:0 20 DataB0 

 
 Table 3 - C CONNECTOR  
 Tek C3/C2 Agilent C1/C0 Tek  
 1 NC 1 2 NC 38  
 2 NC 3 4 NC 37  

MClk 3 CLK:3 5 6 QUAL:1 36 BOTA 
EOTA 4 C3:7 7 8 C1:7 35 SpareAB4 

HoldBOTA 5 C3:6 9 10 C1:6 34 SpareAB3 
 6 C3:5 11 12 C1:5 33  

SpareAB0 7 C3:4 13 14 C1:4 32 SpareCD1 
BadCrcA 8 C3:3 15 16 C1:3 31 User3 
SpareAB2 9 C3:2 17 18 C1:2 30 SpareCD0 
BadCrcB 10 C3:1 19 20 C1:1 29 BOTC 
BadCrcC 11 C3:0 21 22 C1:0 28 SpareCD2 

HoldBOTC 12 C2:7 23 24 C0:7 27 User1 
SpareAB1 13 C2:6 25 26 C0:6 26  

 14 C2:5 27 28 C0:5 25 BOTB 
EOTB 15 C2:4 29 30 C0:4 24 HoldBOTB 

CommaB 16 C2:3 31 32 C0:3 23 User0 
CommaA 17 C2:2 33 34 C0:2 22 User4 
CommaC 18 C2:1 35 36 C0:1 21 User2 

EOTC  19 C2:0 37 38 C0:0 20 User5 
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 Table 4 - E CONNECTOR  
 Tek E3/E2 Agilent E1/E0 Tek  
 1 NC 1 2 NC 38  
 2 NC 3 4 NC 37  

ValidC 3 QUAL:3 5 6 QUAL:2 36 ClkC 
DataC31 4 E3:7 7 8 E1:7 35 DataC15 
DataC30 5 E3:6 9 10 E1:6 34 DataC14 
DataC29 6 E3:5 11 12 E1:5 33 DataC13 
DataC28 7 E3:4 13 14 E1:4 32 DataC12 
DataC27 8 E3:3 15 16 E1:3 31 DataC11 
DataC26 9 E3:2 17 18 E1:2 30 DataC10 
DataC25 10 E3:1 19 20 E1:1 29 DataC9 
DataC24 11 E3:0 21 22 E1:0 28 DataC8 
DataC23 12 E2:7 23 24 E0:7 27 DataC7 
DataC22 13 E2:6 25 26 E0:6 26 DataC6 
DataC21 14 E2:5 27 28 E0:5 25 DataC5 
DataC20 15 E2:4 29 30 E0:4 24 DataC4 
DataC19 16 E2:3 31 32 E0:3 23 DataC3 
DataC18 17 E2:2 33 34 E0:2 22 DataC2 
DataC17 18 E2:1 35 36 E0:1 21 DataC1 
DataC16 19 E2:0 37 38 E0:0 20 DataC0 

 

6 Connecting the TLA to the TMPC-FCA Bus 
 
For correct naming association with the FCA-6 hardware and TMPC-FCA support 
package, the following cable configuration is intended: 
 

FCA-6 HW TLA  
Chan A Connector A, Module 1 
Chan B Connector D, Module 1 
Chan C Connector E, Module 1 
Helper ABC Connector C, Module 1 
Chan D Connector A, Module 2 
Chan E Connector D, Module 2 
Chan F Connector E, Module 2 
Helper DEF Connector C, Module 2 

 
However, a minimum disassembly configuration only requires two cables: one 
connecting the mictor of the channel of interest and one connecting its associated helper 
mictor.  
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7 Custom Clocking Options 
 
The TMPC-FCA support package provides one clocking mode (“FCA Clocking”) with 5 
clock enable options.  These options are selected by clicking on the “More” button next 
to the “Clocking” selection box in the TMPC-FCA Setup window:   
 

“ENABLE ON” DESCRIPTION 
“Always” Capture records on all rising edges of MCLK  
“Valid A,B,or C” Capture records on any valid data 
“Valid A” Capture records on valid channel A data 
“Valid B” Capture records with valid channel B data 
“Valid C” Capture records with valid channel C data 

 
Generally, “Valid A”, “Valid B” and “Valid C” options should be used for normal single-
channel capture and disassembly.   The “Valid A,B, or C” option is used for data-only 
capture and export and is not generally used for disassembly.  The “Always” option is 
used for debugging.   

8 Disassembly  
 

Once the TMPC-FCA support package has been loaded and a trace taken, the Listing 
window will display disassembled S-FPDP data.  In addition to the signal groups defined 
in the Setup window (e.g. DataX, StatusX, ValidX and User), the support package 
defines additional groups for display: 
 
GROUP DESCRIPTION 
TMPC-FCA Data DataX from selected disassembly channel 
TMPC-FCA Comma CommaX from selected disassembly channel 
TMPC-FCA HoldBOT HoldBOTX from selected disassembly channel 
TMPC-FCA BOT BOTX from selected disassembly channel 
TMPC-FCA EOT EOTX from selected disassembly channel 
TMPC-FCA Bad CRC BadCRCX from selected disassembly channel 
TMPC-FCA Mnemonics S-FPDP symbol or FibreChannel ordered set 
TMPC-FCA SOF_Fl S-FPDP flags for SOF symbol 
TMPC-FCA SEOF Fl S-FPDP flags for SEOF symbol 
TMPC-FCA VDataA Valid DataA (if ValidA is low, ‘-------‘ is displayed) 
TMPC-FCA VDataB Valid DataB (if ValidB is low, ‘-------‘ is displayed) 
TMPC-FCA VDataC Valid DataC (if ValidC is low, ‘-------‘ is displayed) 
 
Disassembly options can be found under the Disassembly tab of the Listing display 
properties pages.  To get to these pages, right-click in the Listing data window and select 
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‘Properties’ from the pop-up menu.  The following disassembly options are available for 
the TMPC-FCA support package: 
 
 

OPTION DESCRIPTION 
Disassembly Channel Selects channel A, B, or C for disassembly 
Display Filter Disassembly filtering mode: “Show All”, 

“Show All But Idles”, “Show Data Only” 
CRC Mode Enables/disables CRC mode 
Mnemonic Type Display FPDP symbol or Fibre Channel 

ordered set  
 
Note that the “Display Filter” and “CRC Mode” options affect disassembly display only 
(as opposed to affecting the records captured).  For example, selecting “Show Data Only” 
merely hides non-data records from the display.  On the other hand, selecting the “Data 
Only” switch position on the FCA-6 hardware causes only data words to be passed to the 
TLA for acquisition. 
 
Note also that for single-channel disassembly, changing the “Disassembly Channel” 
option generally requires changing the “Enable On” custom clocking option and vice-
versa.  However, if the “Valid A, B, or C” custom clocking option is selected then all 
valid data from all three channels will be captured and any “Disassembly Channel” can 
be chosen.  In fact, in this mode, the disassembly from each channel can be viewed from 
a single acquisition.   
 

9  Quick Start 
 
The following steps describe a typical initial install and configuration of the TMPC-FCA 
support on a two-module TLA.   
 

1) Install TMPC-FCA support package.  Run the setup.exe provided. 
2) Bring up the TLA application. 
3) In the System window, click in the name field of module 1.   
4) Load the support package into module 1 using “File->Load Support Package”. 

Select TMPC-FCA from the list and click on the “Load” button.  Click “Yes” to 
acknowledge that loading will invalidate acquired data. 

5) In the System window, click in the name field of module 2. 
6) Repeat step 4. 
7) In the System window, click on the Setup icon for module 1.  Adjust the memory 

depth to a reasonable length for quick acquisitions, e.g 4096.  Make sure the 
clocking mode is selected as “Custom” and click on the “More” button.  Choose 
the correct “Enable On” option, most generally “Valid A, B, or C”.  Click OK. 

8) Repeat step 7 for module 2. 
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9) If desired, review the trigger state machine for module 1 (master trigger).  Click 
on the Trigger icon for module 1 in the System window.  The trigger state 
machine has If Anything Then Trigger All Modules.  This will cause both 
modules to acquire all 6 FCA channels simulataneously. 

10)  Connect the TLA cables to the FCA-6 hardware.  Assigning module 1 to FCA-6 
channels A, B, and C, connect the cable as follows: 

 
Module 1 (top) TLA cable A to FCA-6 chan A mictor, 
Module 1 (top) TLA cable D to FCA-6 chan B mictor, 
Module 1 (top) TLA cable C to FCA-6 helper ABC mictor, 
Module 1 (top) TLA cable E to FCA-6 chan C mictor, 
Module 2 (bottom) TLA cable A to FCA-6 chan D mictor, 
Module 2 (bottom) TLA cable C to FCA-6 helper DEF mictor, 
Module 2 (bottom) TLA cable D to FCA-6 chan E mictor, 
Module 2 (bottom) TLA calbe E to FCA-6 chan F mictor 

 
11)  For test, connect the optical fibers pair-wise between adjacent channels such that 

the transmit and receive links for Chan A and B, Chan C and D, and Chan E and F 
are connected. 

12)  Power on the FCA-6.  After a few seconds, the LEDs should light up when the 
hardware has finished initialization.  Place the front-panel switch positions into 
the following state: 

 
CRC  On 
Xmit Tee 
Rate 1G 
Test On (Green LED) 
Mode Pass All 
Format 4th LED  
Module <don’t care> 
Link 6 
 
Note that with the Xmit in Tee, and Test On (Green) the FCA-6 generates a 
simple S-FPDP packet sequence on all its transmit links.  The sequence 
transmitted is determined by Format:  
 
1st LED Idle packets only 
2nd LED Alternating Idle and short Data packets 
3rd LED Repeating sequence of Idle, short Data, 

Sync w/o Data packets 
4th LED Repeating sequence of Idle, short Data, 

Sync with Data packets. 
 

13)  If the fibers are connected properly, the “RxX Good” status LEDs should be on 
(where X stands for A, B, C, D, E, or F).   
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14) Press the Run/Stop button on the TLA or click on the Run button in the TLA 
application to acquire data.  From the System menu, bring up the Listing 1 and/or 
Listing 2 windows to view disassembly.  Add/remove groups as desired by right-
clicking in the window and choosing “Add column”.  Order the groups as desired 
by dragging the group headers right or left.  Change the column widths to suit by 
dragging at the edges of the group headers. 

15)  Right-click in each listing window and click on the Disassembly listing tab to set 
the CRC Mode to Enabled and select a Disassembly Channel as desired.  

16)  Verify that the listings look correct.  S-FPDP packets are highlighted in alternate 
colors for visual framing.  Save your configuration using File->Save System.  
You can then reload this system file to restore your configuration in subsequenct 
sessions.    
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10 DRAGONFLY SOFTWARE LICENSE AGREEMENT 
 
PLEASE READ THIS DOCUMENT CAREFULLY BEFORE USING THE SOFTWARE. 
BY USING THE SOFTWARE, YOU ARE AGREEING TO BE BOUND BY THE TERMS 
OF THIS AGREEMENT. IF YOU DO NOT AGREE TO THE TERMS OF THIS 
AGREEMENT, DO NOT OPEN THE SEALED DISK PACKAGE, INSTALL, OR USE 
THE SOFTWARE. PROMPTLY RETURN WITHIN 15 DAYS THE SOFTWARE, ALL 
RELATED DOCUMENTATION, AND ACCOMPANYING ITEMS TO THE PLACE OF 
ACQUISITION FOR A FULL REFUND. 

This is a legal agreement between you and Dragonfly Software Development 
(Dragonfly). This Agreement states the terms and conditions upon which Dragonfly 
offers to license the software sealed in the disk package, together with all related 
documentation and accompanying items including but not limited to, the executable 
programs, drivers, libraries, and data files associated with such programs (collectively, 
the Software). 

 LICENSE 

1. Grant of License 

The Software is licensed, not sold, to you for use only under the terms of this 
Agreement. You own the disk or other media on which the Software is originally or 
subsequently recorded or fixed as permitted by this Agreement. However, as between 
you and Dragonfly (and, to the extent applicable, its licensors), Dragonfly retains all 
right, title, and interest to the Software and all copyrights to the Software, and reserves 
all rights not expressly granted to you. This is a non-exclusive license. 

2. For Use on Multiple Computers 

The Software may be freely installed and used by you on multiple computers owned by 
you and your company.  

3. Transfer of License 

You may transfer your license of the Software, provided that (a) you transfer all portions 
of the Software or copies thereof, (b) you do not retain any portion of the Software or 
any copy thereof, and (c) the transferee reads and agrees to be bound by the terms and 
conditions of this Agreement. 

TERMINATION 

The license granted to you is effective until terminated. You may terminate the license at 
any time by returning the Software (including any portions or copies thereof) to 
Dragonfly at the address shown below. The license will also terminate automatically 
without any notice from Dragonfly, if you fail to comply with any term or condition of this 
Agreement. You agree upon such termination to return the Software (including any 
portions or copies thereof) to Dragonfly. Upon termination, Dragonfly may also enforce 
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any rights provided by law. The provisions of this Agreement that protect the proprietary 
rights of Dragonfly will continue in force after termination. 

 LIMITED WARRANTY 

Dragonfly warrants, as the sole and exclusive warranty, that the disks on which the 
Software is furnished will be free of defects for a period of ninety (90) days. In the event 
one or more of such disks is defective, Dragonfly will replace the defective disk(s) free of 
charge upon receiving the defective disk at the address set forth below. 

No distributor, dealer, or any other entity or person is authorized to expand or alter this 
warranty or any other provisions of this Agreement. Any representation, other than this 
express limited warranty, will not bind Dragonfly. 

EXCEPT AS STATED ABOVE IN THIS AGREEMENT, THE SOFTWARE IS PROVIDED 
AS-IS WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO, ANY IMPLIED WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 

Dragonfly does not warrant that the functions contained in the Software will meet your 
requirements, or that the operation of the Software will be uninterrupted or error-free. 
You assume full responsibility for the selection of the Software to achieve your intended 
results, and for the installation, use, and results obtained from the Software. You also 
assume the entire risk as it applies to the quality and performance of the Software. 
Should the Software prove defective you (and not Dragonfly, or its distributors or 
dealers) assume the entire cost of all necessary servicing, repair, or correction. 

This warranty gives you specific legal rights, and you may also have other rights which 
vary from country/state to country/state. Some countries/states do not allow the 
exclusion of implied warranties, so the above exclusion may not apply to you. Dragonfly 
disclaims all warranties of any kind of the Software was customized, repackaged, or 
altered in any way by any third party other than Dragonfly. 

 LIMITATION OF REMEDIES AND DAMAGES 

THE ONLY REMEDY FOR BREACH OF WARRANTY IS THE EXPRESS LIMITED 
WARRANTY SET FORTH ABOVE. IN NO EVENT WILL DRAGONFLY OR ITS 
LICENSORS BE LIABLE FOR ANY PUNITIVE, INDIRECT, INCIDENTAL, SPECIAL, 
OR CONSEQUENTIAL DAMAGES, OR FOR ANY LOST PROFITS, LOST SAVINGS, 
LOST REVENUES, OR LOST DATA ARISING FROM OR RELATING TO THE 
SOFTWARE OR THIS AGREEMENT, EVEN IF DRAGONFLY OR ITS LICENSORS 
HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT 
WILL DRAGONFLYS LIABILITY OR DAMAGES TO YOU OR ANY OTHER PERSON 
EVER EXCEED THE AMOUNT PAID BY YOU TO USE THE SOFTWARE, 
REGARDLESS OF THE FORM OF THE CLAIM. Some countries/states do not allow the 
limitation or exclusion of liability for the incidental or consequential damages, so the 
above limitation or exclusion may not apply to you. 

PRODUCT RETURNS 
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If you must ship the Software to Dragonfly or an authorized Dragonfly distributor or 
dealer, you must prepay shipping and either insure the software or assume all risk of 
loss or damage in transit. 

U.S. GOVERNMENT RESTRICTED RIGHTS 

All Software and related documentation are provided with restricted rights. Use, 
duplication, or disclosure by the U.S. Government is subject to restrictions as set forth in 
the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or 
the Commercial Computer Software-Restricted Rights at 48 CFR 52.227-19, as 
applicable. If you are sub-licensing or using the Software outside of the United States, 
you will comply with the applicable local laws of your country, U.S. export control law, 
and the English version of this Agreement. 

MANUFACTURER 

Dragonfly Software Development 
4905 SW Griffith Drive #100 
Beaverton OR 97005 
(503)-643-3800 
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GENERAL 

This Agreement is binding on you as well as your employees, employers, contractors 
and agents, and on any successors and assignees. Neither the Software nor any 
information derived therefrom may be exported except in accordance with the laws of 
the U.S. or other applicable provisions. This Agreement is governed by the laws of the 
State of Oregon (except to the extent federal law governs copyrights and federally 
registered trademarks). This Agreement is the entire agreement between us and 
supersedes any other understandings or agreements, including but not limited to, 
advertising of the Software. If any provision of this Agreement is deemed invalid or 
unenforceable by any country or government agency having jurisdiction, that particular 
provision will be deemed modified to the extent necessary to make the provision valid 
and enforceable, and the remaining provisions will remain in full force and effect. If any 
legal action is brought by you or Dragonfly regarding the Software or this Agreement, the 
prevailing party shall be entitled to recover, in addition to any other relief granted, 
reasonable attorney fees and expenses of litigation. Neither you nor Dragonfly will waive 
any rights under this Agreement, unless such waiver is in writing. For questions 
concerning the Software or this Agreement, please contact Dragonfly at the address 
stated above.  


